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To: 

From: 

Date: July 1, 1992 

Re: Progress Report for Cobb County Project 

This memo constitutes a progress report for the period of project beginning, mid-April to 
July 1 , 1992. Further progress reports will be done monthly. This larger period for the first 
progress report results from transition problems of knowing when the project actually began. 

For this period, the following progress has been made: 

Task 1: Evaluation of Prototype GIS 

Meetings were held with Cobb DOT units to determine most appropriate structure of GIS. In 
addition, a meeting was held with the Director of Cobb DOT and his staff to organize an 
internal management review committee. Task Completion: 80% 

Task 2: Digital Database 

Data has been collected for several of the m~ules in the GIS. Meetings have been held 
regarding accident records and traffic signal data. Task Completion: 20% 

Task 3: Applications 

The intersection database manager is 80% complete. The interface between TRANSYT-7F and 
the GIS is 50% complete. No work has started on TRANPLAN. Task Completion: 20% 

Tasks 4 - 8: Not yet started 



To: 

From: 

Date: 

Re:. 

·William Weikel 
EBASCO, Inc. C a0-X07 

Mich-ael D. Meyer 
Schrol of Civil Engineering 
GeQrgia Tech 

September 1, 1992 

£-;;.o -.xo1 
lP··I-;r 

In early July the research team made a presentation to DOT staffon the status of the project. 
Since then, a great deal of development has occurred in the traffic engineering area. The 
research team has presented a preliminary design for the traffic engineering module. This 
presentation included a demonstration of new capabilities that were adlded to the original 
prototype. Based on an evaluation by the DOT staff, the capabilities that are determint-..d to be 
most useful will be implemented as part of the final system. The research team is also currently 
working on an interface for the GIS with TRANPLAN. An interface has already been created 
from a network standpoint. A second interface will be developed to manage land use 
information that can be used to generate trip production and attraction infcrmation for use by 
TRANPLAN. The estimated progress to date is as folllows: 

Task 1: Evaluation of Prototype GIS: 90% complete 

Task 2: Digital Database: 30% complete 

Task 3: Applications: 35% complete 

Task 4-8: Not yet started 

A reestimated schedule for the project is attached. There is still no expected slippage from 
the agreed upon ending date. 
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To: 

From: 

Date: 

Re: 

Georgia Institute ofTechnology 
Atlanta, Georgia 30332-0355 
USA 
404•894•2201 
404•894•2278 FA.X 

William Weikel ·-~A 
EBASCO, Inc. \ ~Vt. \ ~ tJ J 
Michael D. MeyeA~d Wayne A. Sarasua 
School of Civil Engineering 
Georgia Te.ch 

November 16, 1992 

Work Performed During Months of S~::ptember and October 

During the last two months, a number of meetings were held with key Cobb DOT officials 
to clarify functional issues with regard to the GIS-T. Based on information provided in these 
meetings, a great deal of development has been done in the traffic signal, accident records, 
pavement management and transportation planning modules. Discussions were made with MIS 
officials about the spatial databases that were built at the University of Georgia. MIS stated that 
a centerline database has not yet been developed!. Thus, Georgia Tech will continue to use its 
TIGER based centerline database for development purposes. An updated TAZ database for the 
platinum triangle has been completed. This database represents the core database for the 
Transportation planning module. A program was written that can translate landuse information 
stored in the TAZ database into a TRANPLAN gravity model input file that contains trip 
productions and trip attractions. The estimated progress to date is as follows: 

Task 1: Evaluation of Prototype GIS: 100% complete 

Task 2: Digital Database: 60% complete 

Task 3: Applications: 50% complete 

Task 4: Building the Databases: 10% 

Task 5: Testing the Applications: 10% 

Tasks 6-8: Not yet started 

A re-estimated schedule for the project is attached. The overlapping task efforts are because 
different modules are further along than othe,rs. There is still no expected slippage from the 
agreed upon ending date which is in May of 1993. Presentations of various system components 
is planned to be done in December. At a minimum, these presentations will include the 
Transportation Planning module and the Pavement module. 

An Equal Education and Employment Opponunity Institution A Unit of the Cniversity Svst~m of Georgia 
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To: 

From: 

Date: 

Re: 

William Weikel 
EBASCO, Xnc. 

Michael D. Meyer and Wayne A. Sara.sua 
School of Civil Engineering 
Georgia Tech 

December 21 , 1992 

Work Performed During November 

During the month of November, a meet:ing was held with Cobb DOT traffic engineering 
staff to finalize the database design for the signal information system. We are currently waiting 
for some forms to be completed by DOT staff thalt will identify any fields not yet in the 
database. Once we receive the completed forms, we will be able to finalize the format of the 
database for the signal information system. 'We are also rapping up much of the development 
of the various applications that will be included in tht~ GIS-T. A summary is as follows: 

Traffic signal module. This is the most extensive module in terms of functionality. The 
system. This module is 85 percent complete, but will still require considerable development 
effort because of its scale. 

Accident records. The interface between the GIS database and CAD works. Collision 
diagrams are generated automatically. 

Pavement management. An input system has been developed for doing pavement 
evaluations in the field using a laptop computer. This system is almost complete. 

Transportation planning. The interface to TRANPLAN is complete. We are currently 
calibrating trip rates that are used by the interface to determine trip information used by 
TRANPLAN. 

Because of the holidays, demonstrations of the various system elements to DOT staff will 
not occur until January. The estimated progress to date is as follows: 

Task 1: Evaluation of Prototype GlS: 100% complete 

Task 2: Digital Database: 75% complete 

Task 3: Applications: 70% complete 



Task 4: Building the Databases: 30% 

Task 5: Testing the Applications: 20% 

Task 6: Documentation and Training: 15% 

Tasks 7-8: Not yet started 

A re-estimated schedule for the project is attached.. The overlapping task efforts are because 
different modules are further along than others. While completion of the various modules are 
expected to be done by the agreed upon project ending date, an evaluation period and system 
modifications will require an additional time pe1iod. The length of this period will depend on 
the extent of the modifications that are requilred. It is anticipated that the project will end by 
June, 1993. No additional funding will be necessary to complete the project. 



Georgia Tech 

To: 

From: 

Date: 

Re: 

,.~
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William Weikel 
EBASCO, Inc. 

Michael D. Meyer ~\lt 
School of Civil Engineering 
Georgia Tech 

March 4, 1993 

Work Performed During Febmary 
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The following work was completed during the months of December and January: 

Traffic Engineering Module 

• Two meetings were held with in February with Traffic Engineering staff. Modifications 
to the traffic engineering module wem discussed and implemented. This includes the 
interface to Highway Capacity Software and improvements to the signal maintenance 
work order system. We are not interfacing thf~ work order system with the GIS. 

• Progress continues on the GIS/TRANSYT-7F interface. Many of the major "bugs" have 
been removed. We are in the process of testing it and adding other features to it to take 
advantage of new capabilities of the latest TRANS YT release. 

Accident Records 

• The interface between the GIS database and CAD works and is still being fine tuned and 
tested. The locating of accidents on a dliagram is complex due to limited locational 
information. Thus, an algorithm was developed that offsets accidents slightly so that they 
aren't displayed on top of each other. The diagram can still become cluttered (difficult 
to interpret) when numerous accidents are being displayed at once. This system will be 
demonstrated to Cobb DOT staff in the next few weeks. 

Pavement Management 

• An input system has been developed for doing pavement evaluations in the field using 
a laptop computer. We are currently in1terfacing the system with the GIS database. This 
system will also be demonstrated during March .. 



~ 
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Tranmortation plannine 

• The interface with TRANPLAN was dtemonsltnllted to DOT planning staff a few weeks 
ago. Because of the magnitude of bmduse data needed to expand this system to include 
the entire county, it is questionable on whether or not the system can be implemented as 
it stands now. Alternatively, a scaled down version of the system which would work 
with existing ARC data is being considered. 

We are also developing documentation for the system as the project progresses. 

The estimated progress to date is as follows: 

Task 1: 

Task 2: 
\ 

\ 
Task 3: 

Task 4: 

Task 5: 

Task 6: 

Tasks 7: 

Task 8: 

Evaluation of Prototype GIS: 100% complete 

Digital Database: 85% complete 

Applications: 90% complete 

Building the Databases: 60% 

Testing the Applications: 35% 

Documentation and Training: 35% 

Not yet started 

Direct support on applying the systtem to pavement management and signal 
coordination will be done upon completion of the other tasks (there is 
some overlap with task 7). 

The project schedule has not changed. 'Nhile completion of the various modules are 
expected to be done by the agreed upon project endintg date, an evaluation period and system 
modifications will require an additional time period. The length of this period will. depend on 
the extent of the modifications that are required. It is anticipated that the project will end by 
June unless the modifications desired by Cobb DOT staff are extensive. Fine tuning and support 
will continue past the June ending date. This support will be done at no cost unless major 
modifications are necessary. 

. , .. 
. ;: 



To: 

From: 

Date: 

Re: 

William Weikel 
EBASCO, Inc. 

Michael D. Meyer 
School of Civil Engineering 
Georgia Tech 

April 13, 1993 

Work Performed During March 

The following work was completed during the month of March: 

Traffic Engineering Module 

• Modifications have been made on the work order system. Querying capabilities were 
added. 

• Modif1cations are in the works to the GIS/TRANSYT-7F interface to make it compatible 
with the newest version of the HCM Softwar1e. The input file for the new version is 
binary rather than ASCII (previous version). Enhancements have also been made to 
SIDE (esp. the source flow generator and the geometry editor). We are also working 
on memory problems. 

Accident Records 

• A great deal of fine tuning has been done to the interface between AutoCAD and the 
GIS. The modifications reflect suggestions by Russ Hamilton. We have also done some 
work on the GIS interface. 

Pavement Management 

• Modifications were made to the input system for doing pavement evaluations in the field 
using a laptop computer. We are currently working on memory problems. 

Transportation planning 

• The system is being expanded for the entire county. Because of limited land use info 
(platinum triangle only) the system is being modified to work with ARC data. 



We are currently in the process of finishing a CAD centerline database for major streets that will 
be used as the graphical database for the Traffic Engiineering module. 

We are also developing documentation for the system as the project progresses. 

The estimated progress to date is as follows: 

Task 1: 

Task 2: 

Task 3: 

Task 4: 

Task 5: 

Task 6: 

Tasks 7: 

Task 8: 

Evaluation of Prototype GIS: }()()% complete 

Digital Database: 90% complett~ 

Applications: 90% complete - no change because of suggested 
modifications. 

Building the Databases: 60% 

Testing the Applications: 50% includes modifications 

Documentation and Training: 50% 

Not yet started 

Direct support on applying the system to pavement management and signal 
coordination will be done upon completion of the other tasks (there is 
some. overlap with task 7). 

We are currently waiting on several copies of the newest version of TRANSCAD from 
Caliper Corporation. Once we receive them, we will Joan a few copies to the various divisions 
within the DOT during an evaluation period. We havt~ put together a tutorial using Cobb Data 
in the use of TransCAD. 

While completion of the various modules are near completion, an evaluation period and 
system modifications will require an additional time period. The length of this period will 
depend on the extent of the modifications that are requilred. It is anticipated that the project will 
end by June unless the modifications desired by Cobb DOT staff are extensive (no additional 
budget will be required). Fine tuning and support will continue past the June ending date. This 
support will be done at no cost unless major modifications are necessary. 
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To: 

From: 

Date: 

Re: 

William Weikel .. ~ 
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EBASCO,fuc. \~~~J 
Michael D. Meyer \l \ 
School of Civil Engineeri g 
Georgia Tech 

June 18, 1993 

Work Performed During April and May 
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The following work was completed during the months of April and May: 

Traffic Engineering Module 

• Georgia Tech has completed a centerline database of the Cobb County traffic signal 
network that was initially being develop<:!d by Cobb County. This map database was 
developed in AutoCAD. The newest vc;~rsion of TransCAD, which we have not yet 
received, can convert an AutoCAD drawing into a TransCAD database. Once this 
accomplished, modifications wi11 be mad4~ to make the TransCAD database compatible 
with the Traffic Engineering Module. There i:s still some software development that is 
going on with the Traffic Engineering module;:. The system has over 10,000 lines of 
source code. 

Accident Records 

• The accident record system is ready for pr1esentation waiting receipt of the newest version 
of TransCAD. Once the system is modified to be compatible with TransCAD 2.1, it will 
be demonstrated to Cobb County. 

Pavement Management 

• The pavement management system was demonstrated to Cobb County staff. Cobb 
County is currently preparing a hardcopy ma.p of pavement segments. Once this is 
complete, Georgia Tech will create a spatial database of the new segment information. 
Except for minor modifications, the functionality of the pavement management system 
is nearly complete. Additional modifications will be made after extensive field testing. 

An Equal Educatii,ln a~ Employment Opportunity Institution. 
'-../ 

A Unit of the University System of Georgia 



Transportation plannin~ 

• The system has been expanded for the entire county. Because of the differences between 
the ARC zone system and the Cobb County zone system, there have been difficulties in 
developing adequate equations to convett social economic data into production and 
attraction info. This will be ironed at with Cobb County staff. Except for this difficulty, 
the system is functional and ready to be demonstrated. 

Because of delays in our receipt of TransCAD the system evaluation period will not begin until 
July at the earliest. Support will continue untill Cobb County is satisfied with the four modules. 
Fine tuning will continue as necessary over am indefmite period. No additional budget will be 
required to complete the project unless major changes in system functionality are requested. 
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To: 

;; -c/-o -)(o 7 
School of Civil Engineering \-/1 \/~ 
Georgia Institute ofTechnology 
Arlanta, Georgia 30332-0355 
USA 
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William Weikel c-...?'()- v O 7 
EBASCO, Inc . .L--.:-( 1 /' , A 

Michae!D.Meyer ~..J:J ~~V~ 
School of Civil Engineering, Georgi~L Tech 

From: 

Date: August 10, 1993 

Re: Work Performed During June and July 

The following work was completed during the m?nths~Jwut~4 J.~lY) 

Traffic Engineering Module 

• The traffic engineering module has b~m going through tests and numerous bugs have 
been fixed. The system is almost ready for delivery. We are waiting delivery of the 
newest release of HCS to improve system (:ompatibility. As of today, it has not yet 
arrived. 

Accident Records 

• The system is now compatible with Tra.nsCAlD 2.1. Cobb County is currently reviewing 
information on the Accident Record System.. Once changes have been made based on 
Cobb County's comments, the system will be~ delivered. Mean while, the system is still 
being fine tuned and tested. A spatial d:atabase is currently being developed that includes 
all of the county's accident lo~ations. 

Pavement Management 

• The system is near completion. Georgia Tech is still awaiting a hard copy map of 
pavement segments. 

Transportation plannin~ 

• This system is ready for demonstration. Changes will be needed, but these will be 
contingent on information that will be provided by the County. 

While there have been numerous delays in the systf~m development, it is anticipated that some 
if not all four of the modules will be in place in Cobb County for evaluation within the next 
month. This will be dependant upon information still w be provided by Cobb County for the 
Accident, Pavement Management and Trarnsportation Planning modules. 

An Equal Educ.ation and Employment Opportunity Jnstitution A Unit of the University System of Georgia 
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K. Overview 

This guide is intended as a tutorial to teach the basics of using TransCAD GIS and the 
customized Transportation Planning Module. Section II provides installation instructions of the 
software that accompanies this guide. Section III (General TransCAD Training) introduces the 
user to a number of different TransCAD operations using Cobb County TRANPLAN network 
data set. Section IV concentrates on the Transportation Planning capabilities of the system. 



II. Installation 

This training guide is accompanied by 2 disks. Disk 1 contains the general TransCAD training 
material and Disk 2 contains the Transportation Planning module. Both disks contain files called 
install. bat. 

To install the general training material, insert Disk 1 into your floppy drive. Change your 
current drive to be the one containing Disk 1 (e.g. a:). Type: 

a: \ > ins1tall 

The install batch file assumes that TransCAD is located on the c: drive in the transcad 
directory. If this is not the case, you will have to modify the batch file. The sample databases 
for the tutorial will be located in a directory called c:\transcad\cobbdemo. 

Trans CAD runs much more efficiently if you ust:! a disk cache program such as smandrv. sys. 
Consult your TransCAD manual for the most optimal configuration. 

To install the Transportation Planning Module training material, insert Disk 2 into your floppy 
drive. Change your current drive to be the one containing Disk 2 (e.g. a:). Type: 

a:\ > install 

The install batch file will create several direcltories on your hard disk. 

The directory structure for the transpmtation planning module can be obtained by 
reviewing the install. bat file on Disk 2. All of the directories reside under the TRANSCAD 
directory. Changes to the directory structure willl require changes to the transportation planning 
application files. The application files are us~:::d at program start-up to load the necessary 
databases. You can modify the application files using any ASCII text editor. 



Illl.. General TransCAD Training 

Starting TransCAD 

To start Trans CAD, first move to the directory on your hard disk in which TransCAD is 
installed. If TransCAD is installed on your C:\TR.l~NSCAD directory, you would use the 
following commands to start and begin using TransCAD.. To switch to the C:\TRANSCAD 
directory, type the following at the DOS prompt: 

C: 

C:\ > cd\transcadl 

Next, start TransCAD as f<ollows: 

C:\TRANSCAD>tc cobb 

The word "cobb" in this command is the name of a TransCAD application file (cobb.app). 

This application file is a text file that lists the boundaries of the area to display on the screen and 
lists the databases that can be accessed by this application. 

A TransCAD title screen appears, followed a few moments later by a map. Above the map 
appear the names of seven menus: TransCAD, ]):isplay, Layer, Query, Select, Geography and 
Procedure. The seven menus you see are pant of the TransCad Map Display window. You can 
also see a pointing finger icon on the screen. You can use the mouse to move the icon and 
choose menu options and commands. 

Using the Menus 

You can access menus using either a mouse or the keyboard. In this tutorial, you will learn how 
to use the mouse. First, get started by activating the TransCAD menu. 

1. Move the pointer to the TransCAD menu. 

2. Click and release the left mouse button. 

You now see the TransCAD menu. This is a pu11-down menu that presents a list of commands. 
When a pull-down menu is active, you can move from pull-down menu to pull-down menu or 
from option to option as follows: 
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1. Move the mouse down and up to highlight different commands in the pull-down 
menu. 

2. Move the mouse right and left to display other pull-down menus. 

3. Click both mouse buttons at the same time to leave the menus without choosing 
a command. 

Using TransCAD Commands 

You can access almost all of the commands and capabilities of TransCAD through pull-down 
menus and submenus and pop-up menus. 

A frequently used command is Display Refresh, located under the Display menu. When you 
choose this command, TransCAD redraws the map display with any changes that you make. 

1. Move the pointer to the Display menu, and click the left mouse button. 

2. Note that the Refresh command is highlighted. 

3. Now, click the left mouse button to execute the command. 

Clicking the left mouse button has the same effect as pressing the <Enter> key. From now 
on, we'll say "click <left>" or "click <Enter>" when you need to click the left mouse button 
or press the < Enter > key. 

Changing the Map Display 

Now you can make the map look different by changing the geographic layers that are displayed. 
The map you see has eight layers--Nodes, Streets,, Signal Intersections, Bus Stops, Transit Route 
Links, Accident Records, 1995 Developments, and TAZ Attributes. However, the application 
file contains other layers you can display. 

1. Choose Active Layers from the TransCAD pull-down menu. 

When you execute the Aetive Layers command, a pop-up menu appears, listing all of the 
geographic layers which are a part of this application (as defined by your application file). 

Options that are active or inactive are toggled on and off, using the mouse. 

1. Move up or down to highlight the name of a layer. 
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2. Click the right mouse button to turn the layer on or off. 

As you click <right> on options in the menu,, the block to the left of the layer name is toggled 
on (filled in) or toggled off (cleared). 

Now, try the Active Layers command as follows: 

1. Deactivate all layers except the Streets layer using the mouse. 

2. Click <left> t:o complete the command. 

3. Choose Display Refresh to redraw the map. 

Now, take a few moments to experiment with the Active Layers command. Try some different 
combinations of layers, and see how the map looks when you refresh the display. As you 
experiment, note the following: 

At least one layer must always be active. TransCAD will never allow you to deactivate 
all layers at the same time. 

When the active layer menu is on the screen, you can activate all layers by pressing 
< Alt > A (for All). To turn off all layers except the one that is currently highlighted, 
press <Alt> N (for None). 

Before you continue ... 

1. Choose Active Layers and deactivate all layers except the Street and Signal 
Intersections layers. 

2. Refresh the map. 

Changing the Current Layer 

You saw earlier that any number of layers of data can be active at one time. One of the active 
layers is the current layer. Most TransCAD commands work onlly on the current layer. 

The bottom line of the TransCAD screen always displays the names of the current database and 
the current layer. You can change the current layer using the TransCAD Current Layer 
command. 

1. Choose Current Layer from the TransCAD menu. 

A pop-up menu lists all the layers in the application. Layers that are not active are crossed out 
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in the menu and cannot be chosen. 

2. Highlight Signal Intersections and dicJk: < left> . 

The bottom line of the map display is updated to indicate the name of the current layer. 

Performing a Simple Query 

Behind every item which appears on the map, there is information stored in a TransCAD 
database. The Query One or More command displays the data for a point, line, or area in a 
pop-up window. 

1. Choose Query One or More. (Activate the Query menu, and then choose the One 
or More command.) 

An arrow cursor appears on the screen. Note that the longitude and latitude of the cursor 
are displayed at the bottom of the screen. 

2. Point to one of the signalized intersections (identified by the small red square icons). 

3. Click <left> . 

The Signalized Intersection is highlighted, and infonnation about the signalized intersection 
appears in a pop-up window. 

4. Click <Esc> (that is, press the <Esc> key, or click both mouse buttons at the 
same time) to make the window disappear. 

The arrow cursor reappears. 

5. Continue to click on signalized intersections to display data, or click <Esc> to 
end the command. 

Sometimes, a query might locate more than one item on the map. 

1. Choose Query One or More, and point to a crowded part of the map where many 
intersections are clustered. 

If the cursor is close to only one intersection, the command works as it did before. If the cursor 
is located near more than one signalized inters,~ction,. you will be asked to Identify the Signalized 
Intersection by any number of possible parameters. 

Choose ID to see a list of the ID numbers of all signalized intersections near the arrow cursor. 
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2. Choose ID from the menu. 

A pop-up menu of ID numbers appears. 

3. Choose one ID number from the list of numbers. 

That signalized intersection is highlighted, and th~~ pop-up window appears as before. Spend a 
few more minutes performing queries and changing the active and current layers. 

Changing the Map Scales 

TransCAD can display a map at any scale, from a worldwide scale to the scale of a room inside 
a building. 

Zoom In 

1. Choose Scale from the Display menu. 

A submenu is displayed. This submenu contains commands which change the map scale. 

2. Choose Zoom. 

An arrow cursor appears on the screen. 

3. Move the cursor with the mouse until it is positioned at one comer of a rectangle 
surrounding and click <left> to anchor this point. (Remember, click <left> 
means to click and release the lleft mouse button or to press the <Enter> key.) 

A rectangle appears on the map. 

4. Use the mouse to stretch the rectangle to cover. .. 

5. Click <left> to complete the zoom. 

The map is redrawn showing the area you designated. 

Try zooming in a few more times, aiming for one specific signalized intersection. If you zoom 
in too far, choose Display Scale Previous. This command restores the map to the scale and 
location that existed before the Scale command was used. 

Once you have zoomed in, you can display a key to the map: 

1. Choose Display Key. 
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A small window appears in the corner of your screen containing the entire Platinum Triangle 
area. An arrow icon appears in the small window. It is possible to use this window to zoom 
into some other part of the Platinum Triangle. Click <Esc> to return to your display. 

Other Map Scale Commands 

You can pan across the map using the Display Seale Shift Left, Shift Right, Shift Up, and Shift 
Down commands. 

If you want to see a larger area of the map, you can use the Display Scale Shrink commands 
which shrink the map to the designated percentag,e of its current size, leaving the map centered 
in the same place. 

Another Way of Displaying Data 

So far you have only used the TransCAD Map Disp:lay window. TransCAD has five other 
windows which you can use to look at and analyze data. They include the Data Editor window, 
and Table Editor window, the Conditions window, the Charts window, and the Statistics 
window. 

Activate the TransCAD menu, and review the windows listed below the Active Layers 
command. You can use commands on the TransCAD menu to move from the Map Display 
window to the other TransCAD windows. Right now, move to the Data Editor window. 

1. Choose Data Editor from the TransCAD menu. 

As you can see, the Data Editor window displays data in a worksheet format of columns and 
rows. 

A reverse video highlight indicates the current cell, which is created by the intersection of a 
column and row. You can move the highlight to another cell by clicking < left> with the 
mouse on that cell. Or you can use the arrow keys, the <PgUp> and <PgDn> keys, the 
<Tab> and < Shift> - <Tab> keys, and the: <Hom~> and < End> keys to move all around 
the worksheet. 

Now choose Map Display from the TransCAD menu to return to the map display, and we will 
proceed. 

Selecting Records in a Database 

The commands on the Select menu let you ][dentify, or select, a subset of the entities in the 

10 



current layer. Entities can be selected based on their location on the map, their location relative 
to entities in other layers, or their attributes or characteristics. 

The collection of entities that are selected at any one 1time is referred to as the "selected set". 
Once entities are selected, you can select more entities, remove some entities from the selected 
set (by deselecting them), or select a subset of the entities that are currently selected. This 
makes it possible to combine geographic and attribute queries in a number of ways. 

Start with the Select Several by Radius command. This command locates all of the entities in 
a database that are within some distance of a given point. 

1. Make sure that Signal Intersection is the current layer. 

2. Choose Select Several by Radius. 

An arrow icon appears on the screen. 

3. Move the icon with the mouse until it is positioned at any point near several 
intersections and click <left> to anchor this point. A circle appears on the 
screen. 

4. Stretch the circle using the mouse. 

The center location and radius of the circle (in miles) are displayed at the bottom of the screen. 

5. To move the: circle, click <right> , and move the entire circle with the mouse. 
Click <right> again to change the radius of the circle. 

6. When the circle is the correct size and location, click <left> to complete the 
command. 

TransCAD locates and selects all signalized intersections within the circle, and highlights them 
on the map display. 

The spatial query could have taken minutes or even hours using a standard database manager. 
This illustrates one of the key differences between a GJ[S and standard database manager--spatial 
indexing. With spatial indexing, searches are performed very quickly regardless of database 
SIZe. 

Try one more experiment with this command: 

1. Choose Select Several by Radius, but use a small circle that contains only a 
handful of signalized intersections. 
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Switch from the map display to the data editm (using the TransCAD Data Editor command). 

Instead of displaying every signalized intersection, you only see the signalized intersections that 
were within the circle on the map. 

At the bottom of the screen, the data editor indicates that you are looking only at selected cities 
and towns. Also, the angle brackets ( > <) that surround each row of data indicate that each 
and every signalized intersection you see is in the selected set. 

More Selection Commamlls 

First, try the Select Clear command. This command clears away the "selected set" of records 
and brings up ALL records. For the opposite effect, try the Select All command--this command 
selects every single signalized intersection in the data layer. 

You can use the < Esc > key to cancel any sdection t:;ommand in progress. 

The Select Unselected command inverts the selected set, selecting every record that was not 
selected and deselecting every record that was St;!lected. 

Thematic Mapping 

You saw in previous lessons that all entities you see on the map have data associated with them. 
TransCAD has many features that let you display these data graphically. Maps of this type are 
often referred to as thematic maps. Thematic maps help you understand data and convey 
information more effectively. 

Adding Labels to the Map 

First, return to the Map Display. 

1. Activate the Layer menu. 

This menu contains commands that affect the way in which the current layer is displayed. 

2. Toggle the Labels command by clicking <right> or pressing <Space>. The 
prompt at the bottom of the screen asks to enter a label. Instead, press the @ key 
to bring up a pop-up menu thall lists all attributes associated with each signalized 
intersection. 

3. Choose Inter LOS (which stands for Intersection Level Of Service based on a 
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lettering system from A- Very Good traffic flow ... to F- Very Poor traffic flow) 
from the pop-up menu. This is the data field we will use to label the map. 

TransCAD does not allow labels to overlap on the map display, therefore some intersections may 
not be labeled. To determine which 'WILL appear you must determine their "priority". 

4. Choose an attribute to determine how they will be prioritized. 

5. Now pick "ascending" or "descending" and refresh the map. 

Your signalized intersections are now labeled wi1th specific LOS or Level Of Service which is 
currently experienced at each intersection. 

6. Once you have done this, turn the labels back OFF by toggling the labels box to 
empty under the Layer menu. 

Creating a Thematic Map 

A common type of thematic map uses colors to distinguish areas with different characteristics. 
This kind of a map is also known as a chloropleth map. We will now create one. 

To accomplish this, you will create a theme. A theme is a classification of entities in a layer, 
based on the value of any one attribute. When you create a theme, you also choose colors, 
styles, and/or icons that are used to distinguish the classifications on the map display. 

Use the Layer Themes Create command to create a theme. 

To create a theme: 

1. Choose Layer Themes Create. 

A dialogue box appears on the screen, along with a pop-up menu that llists all of the data fields 
in the signalized intersection layer. 

2. Choose Inter. V/C (for Intersection Volume to Capacity ratio) from the list of data 
fields. 

3. Choose Fixed Interval as the classification method. 

4. Choose the Standard palette .. 

5. Choose None for the style settings. 



The dialogue box shows the four choices you have made. 

6. Move the highlight to Interval (use the mouse or arrow keys) and click <left> . 

A second dialogue box appears, with spaces for you to enter a minimum value, a maximum 
value, and an interval. 

7. Set the minimum value to 0.85, the maximum value to 1.25, and the interval 
value to 0.05. 

8. Move the highlight to Go and click <left> to finish creating the theme. 

9. Finally, use Display Refresh to redraw the map. 

The map display now shows each intersection color coded by its intersection volume to capacity 
ratio. To understand what the colors mean, display the map legend (if it is not currently on the 
screen). 

1. Choose Display Legend Show. 

A map legend appears on the screen showing the meaning of each color and the scale of the 
map. 

Modifying the Legend 

You might want to change the size or location of the legend. 

1. Choose Display Legend Reshape to change the shape of the legend. 

2. Move the mouse up or left to make the legend taller and narrower, or move the 
mouse right or down to make the legend shorter and wider. 

3. Click <Enter> when you are done. 

Now move the legend to a different place. 

1. Choose Display Legend Move. 

2. Use the mouse or the arrow keys to move the legend to a different location. 

3. Click <Enter> when you are done. 

You can also hide the legend using the Display Legend Hide command. 
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Creating a Theme for Street Pavements 

1. Clear the Labels and make Streets the curn:~nt layer. 

2. Choose Layer Themes Create. 

The theme dialogue box appears. 

3. Choose Total Score as the data field. 

4. Choose Fixed Intervals from 0 to 100 using Intervals of 10. 

5. Choose the Standard palette, and None for style. 

6. Click Go and refresh the map. 

Each street segment is color coded by its Total Pavement Score (which shows what type of 
"shape" the pavement is in - Higher numbers are worse!). You may need to zoom in on one 
region of the map to see the theme more cleady. You might also try to change the legend 
shape and location to make the map more presentable. 

Scaling the Width of a Line 

Just as you can use different icons to display points, you can use different widths to display lines 
or boundaries. You can emphasize a layer by drawing it with a wider line. 

1. Choose Layer Line Width. 

A submenu appears with three options. The Fixed Width option is currently active. 

The Fixed Width option lets you set a line width from 1 to 5, where 1 is narrow and 5 is wide. 

2. Click <right> on Fixed Width to change the line width. 

3 . Enter 2 at the prompt in the Message bar and press < Enter> . 

4. Refresh the screen. 

The colors in the theme stand out much more dearly when the line width is increased. 

Now, return the line width to 1 using the above same commands. 
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Creating and Using Conditions 

You need to learn how to select records in a layer based upon the value of one or more 
attributes. You will also learn how to combine spatial selection with queries based on attribute 
values. 

What is a Condition? 

A condition is a logical statement about entities in a database that is based on the value of a 
single attribute or data field. Conditions are used to select records based on these attribute or 
data field. Conditions are used to select records based on these attribute values--for example, 
all signalized intersections with volume to capacity ratios greater than 1. 5. 

To create or edit conditions, you use the Condition window. Make sure the Signal Intersections 
layer is current. 

1. Choose TransCAD Conditions to switch to the Condition window. 

As you can see, several conditions have already been created for this layer. Each condition has 
a name, a data field, an operator, and a value. You enter conditions in the condition editor by, 

-typing a name for the condition 
-choosing a data field from the pop-up menu 
-choosing an operator from the pop-up menu 
-entering a value to use in the 1;::ondition 

You can define up to 32 different conditions for each !layer. These conditions are stored in the 
database, and can be used at any time. When you use a condition, you refer to it by name. 

Now, you can use a few of these conditions. 

1. Choose TransCAD Map Display to return to the map display. 

2. Choose Select Several on Condition. 

You can select entities based on a single condition, on a union of conditions, or an intersection 
of conditions. For now: 

3. Choose to use One Condition. 

A pop-up menu lists the names of all conditions that are stored in the database. 

4. Choose Inter. V/C > 1.25. 
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5. Refresh the Map Display. 

Combining Conditions and Spatial Queries 

You can combine some conditional queries with spatial queries using the Select Subset 
command. Select Subset finds the subset of the currently selected records that meet some other 
conditional or spatial selection. 

1. Return to the map display, zoom into an area of about 5 intersections and choose 
Select Clear to clear the selected set. 

2. Choose the Select Several command. 

3. Click <left> on by Radius, and draw a circle enclosing all of the signalized 
intersections seen in your zoomed in semen. 

TransCAD selects all highway segments that are completely within the circle. 

4. Choose Select Subset on Condition. 

5. Choose One Condition. 

6. Choose INTER DELAY > 120 from the pop-up menu. 

TransCAD examines each of the selected records, and selects those that have Delays of greater 
than 120 seconds. Intersections that have Delays LESS THAN 120 seconds are removed the 
selected set. 

Creating Conditions 

Now, you willl try creating a few conditions of your own. 

1. Choose TransCAD Conditions to display the Conditions window. 

2. Make sure that Signal Intersection is the current layer. 

3. With the cursor under Condition Name below the last condition, type NB ADT 
> 5,000 ADT (for intersection North Bound directions > 5,000 Average Daily Traffic) 
and press < Enter> . 

A pop-up menu of data fields is displayed. 
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5. Choose NB ADT. 

A pop-up menu of operators appears. 

6. Choose "Greater Than" from the pop-up menu. 

7. Enter a value of 5, 000 and press < Enter > . 

The cursor automatically moves down to the next line, so that you can enter another condition. 

You may now use your newly created condition lto find those Intersections with >5,000 ADT 
in the North Bound Direction. 

The Data Editor Window 

Moving Around the Worksheet 

As you have already learned, the Data Editor window displays data in a worksheet format. Each 
row represents one signalized intersection in the current layer, and each column represents one 
data field. The current cell is indicated by the reverse video highlight. 

You can move the highlight in many ways. 

First, choose the Data Editor from the TransCAD menu if you are not presently there. 

1. Click <left> with the mouse to move the highlight to a particular cell. 

2. Use the left, right, up, and down keys to move the highlight one cell at a time. If 
you move off the edge of the screen, new records or data fields scroll into view. 

3. Press <PgUp> or <PgDn> to display the previous or next page of data. 

4. Press <Tab> or < Shift·-Tab > to shift the display to the right or left by a page. 

5. Press <Home> once to move the! highlight to the first data field in a row. Press 
<Home> again to move the highlight to the first row on the page. Press <Home> 
a third time to move the highlight to the first record in the worksheet. 

6. Press <End> once to move the highlight to the last data field in a row. Press 
< End> again to move the highlight to the last row on the page. Press <End> a third 
time to move the highlight to the last record in the worksheet. 

Practice moving around the worksheet using the mouse. 
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You can use commands in the Data Editor window to choose which data fields are displayed and 
the order in which the records appear. 

1. Choose Layer Active Fields. 

A pop-up menu lists all data fields in the Signalized Intersection layer. Fields that are active 
are toggled on and have a filled-in block. 

2. Move the highlight to ID and press < Alt > -N. ( < Alt > -N turns off all of the 
options except the one that is currently highlighted.) 

3. Toggle on a few additional fields. Click <right> to toggle options in a multiple 
choice menu. 

4. Click <left> to complete the command. 

The data editor displays only the fields you chose from the menu. 

Try experimenting. 

1. Choose Layer Active Fields. 

2. Press < Alt > -A to activate all fields. 

3. Click <left> to complete the command. 

Each layer can have one or more key (or indexed) fields that automatically maintain the records 
in sorted order. If you look at the top of the worksheet, you will see that the name of the key 
field currently in use, ID, is highlighted. 

Now, change the field: 

1. Choose Layer Change Key Field. 

A pop-up menu lists the key fields for the signaJized intersection layer. 

2. Choose Inter. Delay as the new key field. 

The worksheet display is changed to show all signalized intersections in order of increasing V /C 
ratios. Page over to the right (using the TAB key) to confirm that the records are in the correct 
order. 

Editing Selecting Records 
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You have seen before that you can use the data editor to display data only on selected records. 
To experiment with this a little more: 

1. Return to the map display (TransCAD Map Display). 

2. Choose Select Several by Pointing, and choose four or five signalized intersections. 

3. Return to the data editor. 

Only the selected intersections are displayed. 

Once again, note the angle brackets at the edge of the screen. Selected records area always 
marked by angle brackets in the data editor. 

You can toggle back and forth between the selected records and all the records by using 
commands on the Layer menu. 

1. Choose Layer Data. 

The submenu indicates that selected records are being displayed. 

2. Change this setting to All Records. Remember to use the toggle button. 

3. Click <left> to complete the command. 

When you choose the All Records option, both selected and non-selected signalized intersections 
are displayed. Note that the angle brackets appear only on selected signalized intersections. 

Selecting Records in the Data Editor 

A special feature of the data editor lets you select or deselect individual records from the 
keyboard. You use the gray < + > key on the numeric keypad to select the current record, and 
the gray < - > key to deselect the current record. 

Printing Data to a Printer or to a File on Disk 

After you make a spatial or conditional query, you might need a printed report that displays the 
results. Try the TransCAD print command to print a report. 

1. Toggle off all fields except ID, North-South Street, East-West Street, and Inter. 
V /C. (Under the Layer Active Fields c:ommand). 
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2. Choose TransCAD Print Printer to print the selected signalized intersections and 
their attributes. 

TransCAD automatically formats and paginates the report. 

Searching for a Record in a Database 

First, use Key Field to find a specific intersection. 

1. Make Signal Intersections the current layer. 

2. Check that all records are displayed (Layer Data All Records). 

3. Make North-South Street the key field (Layer Change Key Field). 

4. Choose Record Find. 

A prompt in the Message bar at the bottom of the screen asks for a North-South Street name. 

5. Type Hargrove (using upper and lower case letters as shown) and press <Enter> . 

The highlight moves to Hargrove Street. 

You could also enter a partial name: 

1. Choose Record Find. 

2. Type Pat the prompt. 

The data editor highlights the first intersection whose name starts with the letter P. 

You can also use this command to find records with numeric values greater than or less than a 
certain value. 

1. Change the key field to Inter. VIC. 

2. Change the order to ascending. 

3. Choose Record Find. 

4. Type 1 . 0 at prompt. 

The highlight moves to the first intersection that has a V/C Ratio of 1.0 or more. 
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Importing Data from Other Programs 

TransCAD makes it easy to import data stored in comma-delimited te:xt files or Lotus 1-2-3 
worksheet files into a TransCAD database. 

1. Make Street the current layer. 

2. Choose Layer Active Fields and activate the following fields: lD, Name, Rutting. 

3. Choose Record [mport. 

A submenu lists two options: Text File and Worksheet. 

4. Choose Text File. 

A menu lists all files with the extension. txt. 

5. Choose file name RUTT.TXT. 

If you do not see it listed in the pop-up menu, change the path to your TransCAD program 
directory. 

TransCAD opens the file, verifies that it contains data in the proper format, and displays a large 
dialogue box: 

This dialogue box may look complicated, but it is very easy to use. Follow these four steps: 

1. Choose a data field from the text file whose values match a data field in the current 
layer. Usually you match data from a text file: to the database using an ID number or 
a name for each record. The only restriction is that the data field in the current layer 
must be a key field. 

Click on the question mark buttons and choose the fields from the pop-up menus. Choose the 
field named ID from the text file and match it with th;: field named ID in the current layer. 

2. Choose the fields to import from the text file. Click on this button to display a pop­
up menu of all the fields in the text file. You can choose up to ten fields at a time to 
import. This text file has only one field, Rutting. 

3. Choose a data field in the current layer to hold each of the fields you are importing. 
In this case, import the Rutting data into the Rutting field in your current street layer. 
Click on each button and choose the destination field from the pop-up menu. 
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4. Finally, click Go to import the data. 

TransCAD reads each row of the text file and looks in the database for a matching ID. When 
a match is found, data in that row of the text file are imported into the current layer. If no 
match is found, the row is not imported. 

When the import is complete, a message displays the number of rows imported and the number 
of rows from the text file for which no match was found. 

Tallying Data Across Layers 

TransCAD is capable of performing very pow~:rful spatial operations. One is the ability to take 
data from one geographic layer and summarize it as an attribute in another layer. In this case, 
you will count the number of intersections located within Traffic Analysis Zone. 

1. Switch to the Data Editor window. 

2. Activate and make current the T AZ Attribute layer. 

3. Move the cursor to the Auxiliary! field, and choose Edit Column Aggregate. 

You can aggregate data from any other layer. The layers are displayed in a pop-up menu. 

4. Choose Signal Intersections. 

You can count the number of intersections in each T AZ, or compute the sum, weighted sum, 
average, minimum, or maximum value of a Signal Intersection field. 

5. For now, choose Count. 

One by one, TransCAD counts the number of signalized intersections wilthin each TAZ, and 
places the number in the Auxiliaryl field. 

Now, try the aggregation function again. Thns time, calculate the average Office Space of the 
Developments located within each TAZ. 

1. Move the cursor to the Auxiliary2 column, and choose Edit Column Aggregate. 

The names of the other layers are displayed in a pop-up menu. 

2. Choose 1995 Developments. 

The operations you can choose appear in a pop-up me~nu. 
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3. Choose sum. 

A pop-up menu lists all of the numeric fields in the 1995 Developments layer. 

4. Choose 1995 SF Office Space. 

TransCAD finds all proposed Office Space in each TAZ, computes the total S.F. (square feet) 
within those TAZ's, and places the result in the Auxihary2 field in the TAZ layer. 

Charts 

In this lesson, you will learn how to create pie charts and bar charts based on attribute data. 
You will also learn how to display pie charts directly on the map display. 

Creating Pie and :Bar Charts 

You will start this lesson by making a pie chart and a bar chart. First, make sure the Signal 
Intersections layer is current. Now, take a look at the Charts window. 

1. Choose Charts from the TransCAD menu. 

TransCAD switches to the Charts window. The Charts window has a different set of menus 
than the map display and data editor. The Charts window also has a status window in the center 
of the screen. The status window describes the chart that will be produced when you choose 
the Go command. 

Fill in the status window as follows: 

1. Choose Chart, Type, and verify that the option pointer is set to Pie Chart. If not, 
click < right> to change the option. 

2. Choose the Settings Data Field command. 

A pop-up menu lists the data fields in the signalized intersection layer. 

3. Choose Inter. LOS from the menu. 

4. Click Go in the menu bar. 

TransCAD displays the pie chart on the screen. 

Now change the pie chart to a bar chart: 
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1. Choose Chart Type, and toggle the option pointer to Bar Chart. 

2. Click Go in the menu bar. 

A bar chart of the same data is displayed on the screen. 

Pie Charts on the Map Display 

TransCAD can also display pie charts directly on the map display. Let's create a pie chart. 

1. Switch to the Map Display and activate ONLY the T AZ Attribute layer. 

2. Zoom in until only the top halif of the 15 TAZ's are displayed. 

3. Choose Display Objects Show Pie Chart. 

A pop-up menu lists all of the numeric data fields in the T AZ Attribute layer. 

4. Choose 3 data fields: Office Employment, Retail Employment, and Other 
Employment. Remember, click <right> to toggle on the three fields, click 
< left> when you are ready to proceed. 

A dialogue box is displayed. 

5. Enter a maximum value of 10,000, a maximum size of 8 percent of the screen 
and a minimum value of 1000. 

6. Click Go to display the pie charts. 

A pie chart is drawn at the center of each TAZ. Thiis size of the pie is proportional to the total 
employment of the TAZ, while the pieces of each pie are proportional to the employment of 
each category. 

You may wish to MOVE or RESHAPE the Legend in order to see TAZ's better. (Using the 
Display Legend Move or Reshape command) 

The maximum size pie is 8 percent of the width of th(: computer screen. 

You can combine the pie charts with other thematic elements such as labels. Experiment with 
some other combinations such as Apartment, Condominium, and Retail Units in each TAZ. 
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IV. Transportation P'lanning 

The Transportation Planning Module is designed to complement TRANPLAN, Cobb County's 
Transportation Travel Forecasting software. The GIS can be used to make updates to the 
TRANPLAN network, and can quickly model changes in socio-economic data for the entire 
Cobb County TAZ system. These modifications can then be directly converted to production 
and attraction information that can be input into TRANPLAN. Thus, alternatives can be quickly 
modeled. 

Starting the Transportation Planning Module 

Enter Trans CAD by typing: 

C:\TRANSCAD>tc cobbtp 

Alternatively, if you are already in TransCAD, you can the application by activating the 
TransCAD pulldown menu and select Appnication, and Change. Choose the cobbtp.app and 
click Go. This will bring up the entire Cobb County travel forecasting network. 

Modifying the Network 

The GIS can be used to modify the TRANPLAN network. 

1. Activate the nodes and centroids layer and the link layer and make the link layer 
current. Deactivate the TAZ layers (TAZ1990 and TAZ2010) and refresh the 
screen. 

2. Activate the Query pulldown menu and select Edit. Choose a link to modify. 

This will bring up the Form View Edit screen. Before making your changes note the from and 
to nodes to be able to verify your changes later. 

3. Make a modification to one of the fields TRANPLAN data fields, and note what 
your changes were. For example, change the Volume field from 0 to some 
positive number. 

4. Quit out of the Form View Ec:llit menu. 

Before we create the TRANPLAN network file, the nodes and links must be selected. To do 
this, use the Select All command to select the links. Next, make the nodes and centroid layers 
current. Repeat the Select All command. 

Finally, we want to run the procedure. 
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5. Activate the Procedure pull down menu. Select the Choose command. Next, 
select the Cobb County Transportation Planning procedures. 

6. Select the Update TRANPLAN Network procedure followed by Generate 
TRANPLAN Highway Network. 

As the procedure works the information about the nodes and links are written to a file that is 
processed by an external program. The resulting file tranplan. dat is in a format that can be read 
by TRANJPLAN. Next, verify that the changes have been made. 

7. Shell out of TransCAD by pressing < F2 > . AT the DOS prompt use a text 
editor, such as the DOS Edit program, to view the tranplan.dat file. Search the 
file for the from and to nodes noted earlier. Check to make sure your changes 
were made. This file can now be processed by TRANPLAN. Note: The header 
information for the input file was taken from the file header. tp. You will want 
to edit this information for your own use. 

Creating a Functional Class Thematic Map 

Thematic maps can also be made using the Links layer. In this layer, we will create a map that 
classifies the links by functional class base on the information contained in the II Link Group 1 II 
field. 

1. Deactivate the nodes and centroids,, and the TAZ layers and make the links layer 
current. Refresh the display. A1ctivate the Layer pull down menu and select 
Themes and Create. 

2. Choose the Link Group 1 data field and select the by Category theme class. 
Choose the standard color palette with None style set. 

3. Select Go and refresh the screen. This produces a color coded map of link 
functional classes. 

You may want to move or resize the legend (undler the Display and Legend ... menus) 

Other Operations 

Experiment using various TransCAD operations on the node and link layers. Some particularly 
useful ones are using the line width feature or perfom1ing conditional queries. 

Creating TRANPLAN Production and Attraction mes from TAZ Data 

This section demonstrates how you can create TRANPLAN compatible Production and 
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Attraction information from socio-economic data stored in the GIS. The socio-economic data 
are associated with TAZ polygons that are stored on the layers TAZ1990 (1990 data) and 
TAZ2010 (2010 data). The process for creating the P & A files is as follows: 

1. Make the T AZ1990 or TAZ2010 layer current. Refresh the display. Choose 
Query, One or More and click on any one TAZ to view socio-economic data 
associated with that TAZ. You. can also edit the socio-economic information if 
you want to make a P & A file that reflects these changes. 

2. Create a selection set of all TAZs by activating the Select pull-down menu and 
then the All command. 

3. Activate the Procedure pull down menu, choose Cobb County Transportation 
Planning, and Create ARC P's & A's File. The procedure will create 
production and attraction infomtation in TRANPLAN format. Continue clicking 
till you encounter "End of Procedure" message. The TRANPLAN compatible 
file created is called panda. in. There are also several other files that are produced 
(see Appendix A for a complete description). 

4. Shell out of TransCAD by pressing < F2 > to view the output files. Type exit at 
DOS prompt to return back to Cobbtp.app application. 

Labeling the TAZs 

1. Activate a T AZ layer and make that layer current. Refresh the screen. 

2. Now label the TAZs by togglilng the JL..abels box under the Layer pull-down 
menu. Press the @ key to bring up a list of the fields included in the TAZ 
database. Select the TAZ NUI\1[BEJR field and press enter. Order based on TAZ 
number/ascending. This last parameter is only used if the label can't fit on the 
display without overlapping another label. Refresh the screen. 

Creating Thematic Maps using the T AZ D~tltabases 

Experiment creating thematic maps based on the socioeconomic data included m a T AZ 
database. The steps for creating a population thematic map are: 

1. Turn labels off by toggling the Labels selection under the Layer pull-down menu. 
Refresh the display. 

2. Select Themes from the lLayer pull down menu and select Create. Create a 
thematic map of population. Use the Fixed Interval class and choose Standard 
color palette and None style set. Select Interval and set: the Minimum Value to 
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0 and Maximum Value to 50000 and Interval of 5000. Select Go. Refresh the 
screen. 

This produces a thematic map indicating the populations of the various zones. You may wish 
to deactivate the link layer if you haven't already done so. 

Let's create a more beneficial thematic map by setting a user defined interval. 

1. Select Themes from the Layer pull down menu and select Create. Create a 
thematic map of population. This time, use the User 1Defined Interval class and 
choose Standard color palette and None style set. Select Interval and set the 
class definitions as follows: 

#1. From 0 to < 500 
#2. From 500 to < 1000 
#3. From 1000 to < 2000 
#4. From 2000 to < 3000 
#5. From 3000 to < 4000 
#6. From 4000 to < 5000 
#7. From 5000 to < 10000 
#8. From 10000 to < 25000 
#9. From 25000 to < 50000 
#10. From 50000 to < 100000 
#11. From 100000 to < 500000 

Select Go. Refresh the screen. 

Another useful feature of TransCAD is the ability to be able to place pie charts right on the map 
display. Let's create such a map. 

1. First select Reset from the Latyer pull-down menu to clear the thematic map 
(refresh the display). 

2. Zoom in until approximately 15 TAZ's are displayed. 

3. Choose Objects from the Displlay pull-down menu. Select Show Pie Chart. 

A pop-up menu lists all of the numeric data fields in the 'f AZ Attribute layer. 

4. Choose the following 5 data fields: Retatil Emp., Comm./Gov. Emp., Industry 
Emp., Construction lEmp., and Misc .. Emp. Remember, click <right> to 
toggle on the five fields, click <left> when you are ready to proceed. 

A dialogue box is displayed. 

29 



5. Enter a maximum value of 10,000, a maximum size of 8 percent of the screen 
and a minimum value of 1000. 

6. Click Go to display the pie chmts. 

A pie chart is drawn at the center of each TAZ. The size of the pie reflects the total 
employment of the TAZ, while the pieces of each pie are proportional to the employment of 
each category. 

You may wish to HIDE, MOVE or RESHAPE the Legend in order to see TAZ's better. (Using 
the Display Legend .... command) 

The maximum size pie is 8 percent of the width of the computer screen. 

You can combine the pie charts with other thematic el1::ments such as labels. Experiment with 
other attributes that are suitable for pie charts SlJtch as using the many income categories that 
exist in the TAZ databases. 

Modifying/Exporting a TAZ Database usin~~ TCBUILD 

The purpose of this exercise is to create a smaller TAZ database that is a subset of an existing 
TAZ database (only TAZs with a population greater than 50,000). The process is as follows: 

1. First select Objects ... Ciear All from the ][)isplay pull-down menu to clear pie 
charts. 

2. Activate the TAZ1990 layer and make it current. Activate the TransCAD 
pulldown menu and select Conditions. Enter condition name "POP". Goto the 
'Data Field' and press the spacebar to identify the data fields in the 1990 TAZ 
database. Select 'Population'. Goto the 'Operator' field and press the spacebar 
and select the 'Greater than' operator. Enter 50000 in the 'Value' field. Press 
< Alt T > to go back to the Map Display. 

3. Activate the Select menu and select Several. .. command. Next select on 
Condition and then One Condition. Choose the POP selection. 

The selected T AZs should appear highlighted on the map display. It is now time to use 
TCBuild. TCBuild is an external utility program supplied with the TransCAD package. You 
will first have to quit out of TransCAD before using TCBUILD. 

4. Within the c:\transcad Directory, type TCBUILD to execute TCBUILD program. 
Activate Database pulldown menu and select Export Setup. Within the Export 
Setup window type c:\transCAD\dbs90 for Location of Database, cbtz90 for 
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Database name and texp.bld for Build File name. Activate Database pulldown 
menu and select Export Selected. 

This sequence will create a "build" file which is an ASCH data file that provides a schema of 
the cbtz90 database. Also created are a pair of comma-delimited data files. Next we will make 
some modifications to the database schema before we rebuild a new database. 

5. Activate the Files pulldown menu and select Open Build File to open texp.bld 
file. Within the Database Infomtation window, type texp when prompted for 
the Name of New Database and c:\temp for the database location. Activate 
Database menu and select Build. This will build a new 'texp' database that 
includes only those TAZs with population greater than 50000. Select Quit from 
Tcbuild menu to exit Tcbuild. 

5. Edit the cobbtp.ajpp file within tht:! c:\transcad directory and add the new 
database texp by adding c:\temp\t1exp under [databases]. 

6. Open the cobbtp.app application to use the new texp database. 

Adding New Data Fields to an existing Database using TCBUILD 

TCBUILD provides a mechanism for adding, removing, or modifying fields from an existing 
database. The purpose of this exercise is to add a new field into an existing database CBTZ90 
within the directory c:\transcad\dbs90 and create a new database called temp in the directory 
c:\temp. 

1. Within the TransCAD Directory, type TCBUILD to enter the TCBUKLD 
program. Activate the ])atabas~e: pulldown menu and select Export Setup. Within 
the Export Setup window type c:\transcad\dbs90 for the location of the 
database, CBTZ90 for the database name and temp.bld for build file name. 
Activate the ][)atalblase pulldown menu and select Export All. 

2. Activate the Files pulldown menu and select Open Build File to open temp.bld 
file. Within the Database Information wilndow, type temp for the database name, 
and c: \temp for the database location. 

3. Activate the Edit pulldown menu and select Layer and choose CBTZ1990. 
Activate the Edit pulldown menu and select the Field menu. Select any one field 
within layer CBTZ1990. Now to add new field activate Edit pulldown menu and 
select Add. Within the Field Window, type a new field name to replace 'Field 
Name'. Decide whether the new field is supposed to be a key field (especially 
useful for sorts and searches lbas,ed on this field) or a non-key field. Toggle 
between options by pressing the spacebar. Select appropriate data type within 
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'Data type'. 

Once you have initialized above parameters for the new field, you are now ready to 'build' the 
database. 

4. Activate the Database menu and select Build. This will create the 'temp' 
database. Select Quit from Tcll>uild menu to exit Tcbuild. 

5. Edit the cobbtp.app file within the c::\transcad directory and add the new 
database 'temp' by adding c:\templ\temn> under [databases]. 

6. Open the cobbtp.app application to use the new temp database. Go into the data 
editor and tab over to see your new field. 
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Appendix A 

Files/Programs/Database mte(:essary to run 
COBB COUNTY TRANSPORTATli:ON PLANNING procec:llure 

Files 

1. [path]\t:ranscad\cobbtp.app 
The application file for using the transportation planning module. 

2. [path]\transcad\procs.mmn (do not copy onto existing procs.mnu, but make addition to 
add new procedure menu options.) 

3. [path]\rranscad\procs\trpgen.cmd 
Command file for "Create ARC P's and! A's" procedure. 

4. [path]\transcad\procs\createtp.cmd 
Command file for "Create TRANPLAN network" procedure. 

5. [path] \transcad\procs \clean.exe 
An executable file that rearranges and cleans data within the household datafile 
archh.dat and the socio-economic data in arczn.dat files to make it compatible 
with input files for trpgen.exe. 

6. [path]\transcad\procs\trpgen.exe 
An executable file that generates P's and A's based on old ARC balancing 
factors. It requires archh.dat and arczn.dat files created by "Dump Attribute" 
command in the trpgen.cmd file. The files it creates includes cobbpr.dat, 
cobbat.dat and arcrepor.out files which are the production data file, the 
attraction data file, and the report file n:spectively. 

7. [path]\transcad\procs\newrep.exe 
An executable file that rebalances P's andl A's based on new ARC Balancing 
factors and generates a new newrep.out report file. Also, a TRANPLAN 
compatible P's andl A's file, panda.in, is created. 

8. [path]\transcad\procs\gis2tp.exe 
An executable file that creates a tranplan compatible network file (tranplan.dat) 
using the network database. 
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Databases 
1. [path]\transcad\dbs90\cbtz90. * 
2. [path]\transcad\dbs21 \cbtz20. * 
3. [path]\transcad\dbs90net\cobbnet. * 
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